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Logging in to Banner 

In contrast to our legacy administrative systems, which ran on a mainframe 
computer, Banner runs in an Internet environment (referred to as INB or Internet 
Native Banner). 
 

• Access Banner at:  http://portico.angelo.edu  or http://banner  
• Click “Logon to Banner” 

 
• Click the Banner Logon Link 

 
Like most information systems, you will have to supply a username and 
password. Your username is the same as your email account name (usually first 
initial last name, up to eight characters). You will be assigned a temporary 
password which must be changed immediately upon logging in the first time. 
 
NOTE: When Banner is accessed for the FIRST time on a computer, a prompt 
will appear to download and install the Oracle JInitiator plug-in. (See page 14 for 
installation instructions) After JInitiator has been successfully installed; the typical 
login screen should appear. If it does NOT appear, close the browser, reopen it, 
and go to the Banner web address again. 
 
IMPORTANT: In the status bar at the bottom of the desktop, there will be an 
Internet Explorer window AND an Oracle window open when Banner is running. 
The "Oracle Developer Forms Runtime - Web" window looks like a teacup with 
steam rising. If either of these windows is closed, Banner will terminate.  
 
Once the Oracle window loads, the logon dialog box will appear: 
 

• Click the Username field 
 
• Enter your username 

 
• Tab to the Password field  

 
• Enter your password 

 
• The Database field will be filled in with the name of the database. 

 
Click {Connect} or press Enter. 
 
When you login for the first time, you will need to change your password.  The 
password will expire every 120 days.  A warning will be displayed when you need 
to change your password.  The procedure for changing your password is 
described on page 12. 
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Layout of Banner Screen 

 
 
1. Menu Bar – contains pull-down menus of functions and commands that can 

be performed in Banner.  If the menu is dimmed, that item is not 
available. 

 
2. Tool Bar – contains buttons to access commonly used tasks 
 
3. Title Bar – shows the descriptive name, the seven character form code, 

versions number, and database name.  This information may be 
modified in the preferences section. 

 
4. Direct Access – enables quick access to forms 
 
5. Banner Forms Menu Area – hierarchical tree structure 
 
6. My Links – Customizable area to display links to various websites.  This 

information is modified in the preferences section. 
 
7. Auto Hint Line – displays hints, error messages, number of records, and if a 

List of Values is available  
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Form Names 
Each form in Banner is identified by a seven character code. Knowing the 
position format of the form code will help you become familiar with commonly 
used forms. 
 
Example:  [GUAPSWD] 
 
Position 1 – the primary system owning the form. 
 
 Most common systems are:  

A – Advancement P – Human Resources / Payroll 
F – Finance R – Financial Aid 
G – General S - Student 

 
[GUAPSWD] belongs to the General system 
 
Position 2 – the module owning the form 
 
 Unique to the product identified in position 1 
 
[GUAPSWD] is a utility form in the General system 
 
Position 3 – the type of form 
  
 Same for all products: 

A – Application R – Rule Table 
B – Base Table V – Validation 
I – Inquiry M – Maintenance 
P – Process  

 
[GUAPSWD] is an application type 
 
Positions 4 – 7 – unique four character code for form 
  
[GUAPSWD] assists in changing the user password 
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Accessing Forms 
Forms can be accessed through the Banner Forms Menu Area or the Direct 
Access field. 
 
Opening forms from the Banner Forms Menu (located in [GUAGMNU]): 

• Click the plus symbol (drill-down) to expand the appropriate category 
• Continue to drill down, until the correct form is located 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

• Double-click the form name to open it 
 
Opening forms from the Direct Access field (located in [GUAGMNU]): 

• Click once in the Direct Access field 
• Type in the form’s seven character code 
• Press Enter  
• The form will open 

 
Opening forms from the File menu: 

• Click the File menu and select “Direct Access” 
• The “Go To...” box will appear at the top of the form 
• Type in the form’s seven character code 
• Press Enter 
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Once you have opened a form, it will appear at the bottom of the File menu 
 

 

 

Parts of a Form 
Common elements you will find on a form: 
 

 
 
1. Menu Bar – access various functions to perform on the form 

(If the menu is dimmed, it is inactive) 
2. Toolbar – contains one-click access to commonly used functions 
3. Key Block - The first block of a form. It contains identification information 

related to the form’s function. It allows you to search for the unique 
identifier or the record you want to view. To move from the Key Block, 
you must perform a Next Block function 

4.  Search icon – Assist you in conducting a search for values of the field 
5.  Information Block – Displays data associated with the Key Block.  Use the 

Next Block function to navigate through multiple blocks. 
 
 

1 2

3 

5 

4 
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Navigating Forms 
 
There a multitude of ways to navigate Banner 
forms: 
 
Options menu – 

• Select the Options menu to see a list of 
related forms 

• Context specific to the active information block 
 
Block menu –  

• Use to perform the Previous, Next, and Clear block function 
 
Scroll Bars –  

• May be located on the horizontal right of a form, or at the bottom of a form 
• Make sure that the form is expanded fully, so you will know if there are 

any bottom scroll bars 
 

 
Toolbar –  

• Contains buttons to easily perform menu functions 

 

 Function Keyboard 
Shortcut Description 

 Save F10 Saves all changes made 

 Rollback Shift + F7 Clears all information and returns to the Key 
Block 

 Select Shift + F3 Enters the highlighted value into the current 
field 

 Enter Query F7 Activates the Query function 

 Execute Query F8 Uses criteria to search the database 

 Previous Block Ctrl + PgUp Moves to the previous information block 

 Next Block Ctrl + PgDn Moves to the next information block 

 Online Help  Displays information about the active form 

 Exit Ctrl + Q Closes the form.  Will exit Banner if you are in 
a menu. 
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Creating a Personalized Menu with My Banner 
 
My Banner is a feature of the Banner system to create a personalized menu of 
frequently accessed forms. 
 
Logon to Banner: http://portico.angelo.edu  
 
REMINDER:  Both windows must remain open, or the Banner session will end. 
 
Open “My Banner Maintenance” form [GUAPMNU]: 
 

• Use the Direct Access method 
o In the Direct Access field, type GUAPMNU  
o Press Enter 
 

• Use the Banner Forms Menu Area 
o Click the plus sign beside “My Banner” 
o Double-click “Empty; Select to build [GUAPMNU]” 

 

Adding a Form 
• Scroll to find the form you wish to add 
 
• Click once on the name of the form.  The name of the form will turn white. 

 
• Click on the right arrow to add the form to My Banner 

 
Another way to add a form to My Banner is to manually type in the seven 
character code. 
 

• Click below the Name category in the right side pane of the form. 
 

• Type in the form code  
o Ex. [GUAPSWD] is the form to change your password 

 
• Press Enter 

 
Notice the description of the form will be added automatically. 



 

Angelo State University 
Portico Project Office 
(325) 942-2385 

A Member of the Texas State University System 
 

http://portico.angelo.edu 

9 

 
 
 

• Click the Save button  to save the contents of the menu. 
 
• Close [GUAPMNU]   

 
NOTE: The change to the contents of My Banner will not appear until you exit 
Banner and logon again. 
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Querying to Locate a Form 
If you do not know the seven character code of a form, you can execute a query 
to find it. 
 

• Click once in the left pane of [GUAPMNU] 
 
• Select Enter Query from the Query menu (F7)  
 
• Enter the search criteria using the wildcard (%) if necessary 

 
• Select Execute Query from the Query menu (F8)  

Changing the Description of a Form 
Banner will add a description for the form automatically.  However, you may 
change the description to suit your needs. 
 
Add the form [FGIBDST] 
 
The description of the form will be highlighted in blue. 
 
NOTE:  If you click off of the description, you can highlight the entire description 

by triple-clicking it. 
 

• Type a new description. 
o Ex. “View the department budget” 

 
• Press Enter. 

 
• Save the menu. 

Removing a Form 
There may come a time when you no longer need to access a form.  You will 
want to remove it from the My Banner menu. 
 
Open the My Banner form [GUAPMNU] 
 

• Click once on the form(s) you want to remove.  The text will turn white 
 

• Click the left arrow.    (Or choose Record – Remove) 
 

• Save the menu. 



 

Angelo State University 
Portico Project Office 
(325) 942-2385 

A Member of the Texas State University System 
 

http://portico.angelo.edu 

11 

Make My Banner the Default Menu 
 
When you logon to Banner, notice that My Banner is collapsed, while Banner is 
expanded to reveal the many form categories. The Preferences section can be 
used to make My Banner expanded and Banner collapsed when you logon. 
 

• Choose File – Preferences 
o [GUAUPRF] will open.  

 
• Click the {Menu Settings} tab 

          
 

• In the User Default field, type  “*PERSONAL” 
 

“My Banner” will appear automatically in the next field. 
 
 

 
• Click the Save button  
 
• Click {OK} 

 
• Click {OK} 

 
For changes to be applied, exit Banner and logon again. 
 
The next time you logon, you will see My Banner 
expanded, and Banner collapsed. 
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Changing Password 
Your password will be active for 120 days.  When the password has expired, a 
warning will appear, and you will need to change your password. 
 

• Open the form [GUAPSWD] 
 

• Enter in the appropriate information 
 

• Click {OK} 

 
 
Some restrictions to your password: 

• Must be at least 6 characters in length 
• Cannot be your username 
• Numbers and letters are accepted, and a few other characters 

o  _ , - , + , * , ^ , !  are accepted 
• Must be a different password from previous two changes 
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Appendix 
 



 

Angelo State University 
Portico Project Office 
(325) 942-2385 

A Member of the Texas State University System 
 

http://portico.angelo.edu 

14 

Oracle JInitiator Installation   
 
Before using Banner for the first time, you will need to install JInitiator.  
JInitiator enables your computer to display a Java applet in which the Banner 
interface resides.  The installation takes approximately two minutes to complete. 
 
Point your browser to http://portico.angelo.edu  
 
Click Logon to Banner on the left hand side menu 
 
Click Banner Logon 
 
Another browser window will open, 
and a security warning dialog box 
will open. 
 
Click Yes 
 

 
 
 
 
 
 
 

 
 
 
 
The browser window will be 
replaced with an install screen.  
Another dialog box will open.   
 
Click Next 
 
 
 
 
 
 
 
 
 

 
 
The installation process will begin. 
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When installation is complete, the following dialog box will appear. 
 
 
 
 
 
 
 
 
Click OK 
 
The browser window will change slightly, a 
Java window will open (Oracle Developers Forms Runtime - Web),  
and the Banner logon dialog box will appear. 
 
 

 
 

 
 
Congratulations! Your computer is now configured to use the Banner system. 
 

** REMEMBER ** 
 

If you use another computer to access Banner, you may need to go through 
these steps again, if JInitiator has not been installed by a previous user. 
 
Both windows must stay open for your Banner session to remain active. 
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 Banner Shortcuts 
FUNCTION KEYSTROKE FUNCTION KEYSTROKE 

 FORM  QUERY 
   Command Menu  Alt key    Cancel Query  Ctrl - Q 
   Clear Form /Rollback  Shift-F7    Count Query Hits  Shift - F2 
 BLOCK    Enter Query  F7 
   Next Block  Ctrl - Page Down    Execute Query  F8 
   Previous Block  Ctrl - Page Up    Exit With Value  Shift - F3 or Enter
   Clear Block  Shift - F5    Wildcard  % 
 FIELD  OTHER 
   Clear Field  Ctrl - U    Commit /Accept /Save  F10 
   Duplicate Field /Item  F3    Menu  Alt key 
   Next Field  Tab or Enter    Enter  Enter 
   Previous Field/ Item  Shift - Tab    Exit /Cancel  Ctrl - Q 
   Delete Backward  Backspace    Print  Shift - F8 
   Delete Character  Delete    List of Values  F9 
 RECORD  CURSOR MOVEMENT 
   Clear Record  Shift-F4    Left  Left Arrow 
   Remove Record  Shift - F6    Right  Right Arrow 
   Duplicate Record  F4    Move Left One Word  Ctrl - Left 
   Insert Record  F6    Move Right One Word  Ctrl - Right 
   Next Record  Down Arrow    Scroll Up  Page Up 
   Previous Record  Up Arrow    Scroll Down  Page Down 
   Next Set of Records  Page Down  HELP 
     Help  F1 
       Show Function Keys Ctrl - F1 
 

 Function Keyboard 
Shortcut Description 

 Save F10 Saves all changes made 

 Rollback Shift + F7 Clears all information and returns to the Key 
Block 

 Select Shift + F3 Enters the highlighted value into the current 
field 

 Enter Query F7 Activates the Query function 

 Execute Query F8 Uses criteria to search the database 

 Previous Block Ctrl + PgUp Moves to the previous information block 

 Next Block Ctrl + PgDn Moves to the next information block 

 Online Help  Displays information about the active form 

 Exit Ctrl + Q Closes the form.  Will exit Banner if you are in 
a menu. 
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Support System 
 
Your first point of contact for Banner support should be the Portico website. 
 
http://banner.angelo.edu 
 
This site contains training materials, news updates, a preview of the Luminis 
portal, and a FAQs page for common issues. 
 
Utilize the Ask Portico feature, located in the FAQs section, to submit questions 
and comments. 
 
Clicking the Bookshelf button on the toolbar will open the Banner Documentation 
Bookshelf (PDF format). 
 

• Click the Bookmarks tab if it is not already open  
 
• Click the plus sign beside “General” 

 
• Click the plus sign beside “User Guide” 

 
• Click “2 Using SCT Banner” 

 
• This section is also available on the Portico Training Library website 

 
The next step would be to call (1-866-942-2911) or email 
(helpdesk@angelo.edu) the IT Help Desk.  The IT Help Desk will assist you with: 
 

• Password resets 
 
• Username recall 

 
• Basic Navigation 

 
• Basic Troubleshooting 

 
If the problem is related to a particular system (i.e., question regarding a 
Purchase Order), the IT Help Desk will direct you to the appropriate person for 
assistance. 
 
 


